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Chapter 1: Introduction 
Welcome to the Test Automation on Windows Embedded Compact 7 Getting Started guide. This 

document will assist you with installing, configuring and using M-eux Test. To make sure you can get 

started automating your test cases as soon as possible, we invite you to closely follow the instructions 

contained in this guide.  

We have made every attempt possible in making the instructions in this guide as clear as possible. 

However, we recognize that we are unable to cover everything in a single guide. Should you require 

further assistance, please do not hesitate to visit our www.jamosolutions.com website or to contact our 

support team at support@jamosolutions.com. 

After reading his document, you should be familiar with the following topics: 

 Test automation on real Windows Embedded Compact 7 devices 

 Test automation on Windows Embedded Compact 7emulators 

 Best practices on Windows Embedded Compact 7 testing 

1.1. M-eux Test overview 

To test mobile applications using M-eux Test, you need three main components. The Windows 

Embedded Compact 7 device or Windows Embedded Compact 7 emulator hosts the application that 

you want to test. You use a scripting environment in which you write and execute your scripts. Finally, 

the M-eux Test Device Manager is the core of our application and acts as the gateway between the 

mobile devices and scripting environment. 

M-eux Test currently supports the following products: 

 Windows Embedded Compact 7 Devices: Both Windows Embedded Compact 7 emulators and 

real actual devices are supported. This connection can be established through USB via 

ActiveSync or Windows Mobile Device Center (Windows Vista), or the network connection of 

the device. 

http://www.jamosolutions.com/
mailto:support@jamosolutions.com
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Figure 1: M-eux Test Architecture 

1.2. How to use this document 

This document will get you started with using M-eux Test for testing applications on Windows 

Embedded Compact 7. To get started, here’s what you need to do: 

- Get your PC ready. You will first need to install M-eux Test on your PC. 

- Get your device or emulator ready. Depending on your testing strategy, you may want to run 

your test on a physical device or an emulator. M-eux Test supports both.  

- Get your app ready. M-eux Test captures information of your app through instrumentation. To 

make your app testable, you need to instrument your app. 

- Create your first script. Once your pc, device and app are ready, you can start creating your first 

script.  

1.3. Where to go from here 

This document will get you started creating your first script. If you want to further explore the features 

of M-eux Test, please visit our website at www.jamosolutions.com for further information on the 

features of M-eux Test.  

http://www.jamosolutions.com/
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Chapter 2: Get your PC ready 

2.1. System Requirements 

The supported systems and requirements: 

Computer/processor IBM-PC or compatible with a Pentium III or higher (Pentium IV or 
higher recommended) microprocessor. 

Operating System Windows Desktop 

 Windows XP 32-Bit Edition—Service Pack 3, 

 Windows Vista (32-bit edition & 64-bit Edition), 

 Windows 7 (32-bit Edition & 64-bit Edition) 

 Windows 8 (32-bit edition & 64-bit edition) 

 Windows 8.1 (32-bit edition & 64-bit edition) 
 
Windows Server 

 Windows Server 2003 32-bit Edition—Service Pack 1, 

 Windows Server 2003 R2 (32-bit x86), 

 Windows Server 2008 (32-bit & 64-bit edition) 

 Windows Server 2008 R2  

 Windows Server 2012  

 Windows Server 2012 R2 

Memory Minimum of 2 GB. 

Color Settings Minimum of High Color (16 bit). 

Free disk space 1 GB of free disk space for application files and folders and an 
additional 1 GB of free disk space on the system disk (the disk on 
which the operating system is installed). 
The free disk space requirements do not include disk space required 
for any prerequisites that may need to be installed before installing 
M-eux Test. 
After M-eux Test is installed, it is recommended to have at least 1 GB 
free disk space on the system disk for the operating system and M-
eux Test to run correctly. 

2.2. Prerequisites  

To install M-eux Test on your computer, you first need to install the following prerequisites: 

- Windows Compact Embedded 7 Emulator (if using Emulator, not required when using real 

device).  

- On the emulator the .NET Compact Framework 2.0 needs to be installed. 

- Optionally, OCR components 
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Once all prerequisites have been installed, you can continue with the installation of M-eux Test. You 

may be required to execute some post-configuration tasks to ensure M-eux Test will work correctly in 

your environment. 

2.2.1. Mobile Device Prerequisites 

In case of Windows Mobile devices and emulators, ActiveSync from Microsoft is needed in order to 

connect the PC to the mobile device for Windows XP and Windows 2003. Windows Vista and Windows 7 

require the Windows Mobile Device Center. 

In case of Android devices, the SDK of Android needs to be installed together with the USB drivers from 

Android in order to connect the mobile device with the PC using a USB cable. 

In case of BlackBerry devices, the “BlackBerry Desktop Software” needs to be installed. 

For iOS devices – you can download the latest iTunes from apple website. 

2.2.2. Required Privileges 

You need to have local system administration rights in order to install the product. 

2.2.3. Visual C++ 2010 Redistributable 

M-eux Test requires the Visual C++ 2010 Redistributable to be installed on your PC. You can download 

the Visual C++ 2010 Redistributable from http://www.microsoft.com/en-

us/download/details.aspx?id=8328 . 

2.2.4. .NET Framework 4.0 

M-eux Test requires version 4.0 of the .NET Framework to be installed on your PC. You can download 

the .NET Framework from http://www.microsoft.com/en-us/download/details.aspx?id=17718 . 

2.3. Installing M-eux Test  

In order to test applications on Android devices or Android emulators, you need to install the M-eux 

Device manager. As shown in the architecture, the device manager is used to communicate between the 

device and the test tools. 

You can download the set up on our website:  M-eux Test Setup at 

http://www.jamosolutions.com/memberArea/downloads.php. You will need to have a credential to log 

in the member area network. If you do not have the credentials yet, please email us at 

info@jamosolutions.com 

It is mandatory to install the application with admin rights, simply right click on the MeuxSetup.msi and 

run as admin rights. 

2.3.1. Preparation 

1. First step is to execute the MeuxSetup.msi file from the M-eux build you downloaded on your PC. 

The dialog boxes will guide you through the installation. 

2. Click Next 

http://www.microsoft.com/en-us/download/details.aspx?id=8328
http://www.microsoft.com/en-us/download/details.aspx?id=8328
http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.jamosolutions.com/memberArea/downloads.php
mailto:info@jamosolutions.com
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Figure 2 Installing M-eux Test 

3. Setup will check the components which are already installed on the pc and will indicate if any 

additional component is required. Review all warnings and errors and click Next to continue the 

installation process. 

 

Note: The Android SDK check will issue a warning if you have downloaded and copied the zipped 

version of the SDK. No warning will be displayed if you have used the installer to install the Android 

SDK. Please see the instructions here for more information. 

 

4. If you agree with the License Agreement, select I accept the terms in the License Agreement and 

click Next. 
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Figure 3 Accepting license 

5. Select: 
a.  Unified Functional Testing (QuickTest Professional) if you want to use M-eux Test with 

QTP/UFT.  
b. Select Visual Studio 2005 if you want to use M-eux Test with Visual Studio 2005 sp1.  
c. Select Visual Studio 2008 if you want to use M-eux Test with Visual Studio 2008 sp1.  
d. Select Visual Studio 2010 if you want to use M-eux Test with Visual Studio 2010.  
e. Select Visual Studio 2012 if you want to use M-eux Test with Visual Studio 2012.  
f. Select Visual Studio 2013 if you want to use M-eux Test with Visual Studio 2013.  
g. Select Execution M-eux Visual Studio scripts if you want to execute only Visual Studio based 

scripts on this PC.  
h. Select Eclipse Extension if you want to use M-eux Test with Eclipse 

Note: You cannot extend Visual studio 2008 and Visual studio 2005 at the same time. 

 

Figure 4 Choose Extensions 

6. If you have selected the Eclipse Extension then setup will ask you to point to the directory where 

Eclipse is installed. Please make sure you point to a 32-bit version of Eclipse. 
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7. Click on “Install” to start the actual installation. 

 
8. Wait until Setup is has completed. Depending on your environment, this may take up to 10 minutes 

as setup is preparing your PC for smooth automation. 
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2.4. License activation 

Start the device manager application on the PC. 

When starting the first time the device manager, you get the device manager without possibility to 

connect devices or tools. You have to install a license first. Depending on the purchased license(s), you 

can choose between seat, site and token license. 

Seat License activation 

In case of a seat license, select the menu Tools, License, New license, Seat. Write down the locking id 

and send this id to Jamo Solutions: support@jamosolutions.com. Jamo solutions will return the file with 

the license keys. A path name to this file needs to be entered in the edit field linked to the Seat License 

Details section. You can write the path manually or use the ‘Select button’ to find and select your license 

key file. 

 

Figure 5 Seat license activation 

After selecting “OK”, the file will be read and the seat license will be installed. 

mailto:support@jamosolutions.com
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Site license activation 

In case of a site license, select the menu Tools, License, New license, Site. Enter the IP or hostname and 

port of the license server.  The license server URL will be generated automatically. 

 

Figure 6 Site license activation 

Note that prior to connecting to the license server machine, the license server needs to be installed on 

that machine.  The licenses will be checked at run-time, so you need to be connected to the license 

server all the time while using the Device Manager. 

If you have problems connecting to the license server, then please contact your product administrator 

who is responsible for the M-eux license server. 

Note the site license will be released if you shut down your device manager. So if you want to transfer 

the site license to another tester in your company. You just needto shut down your Meux Device 

Manager. 

Token license activation 

Token licenses are distributed by your local license server. They allow you to use the tool while not 

being connected to the license server. 

In case of a token license, select the menu Tools, License, New license, Token. In the details enter the IP 

or hostname and port of the license server.  The license server URL will be generated automatically. 
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Figure 7 Token license activation 

Note that prior to connecting to the license server machine, the license server needs to be installed 

activated and running on that machine.  

 The checkbox Web Add-in consumes a web support for each tool demanded license. 

 The Token # days edit field contains the number of days that the token will be used by the 

machine, i.e. the number of days that the token will be valid. 

 The checkbox DM Professional denotes the license for the device manager professional edition. 

A license device manager professional activates the WAN Connector and local scheduler 

functionality. 

 The checkboxes Specific Platform and Platform All denote the platform of your connected 

devices. Only one of these checkboxes can be checked.  

 If you check Specific platform you have to select in the combo box under the platform you wish. 

If you select nothing, the Windows Mobile/CE platform will be levied. Selecting Windows 

Mobile/CE denotes that Mobile-based or Windows CE-based devices can connect to the Device 

Manager directly or indirectly through the WAN connector. Selecting Android denotes that 

android-based devices can connect to the Device Manager directly or indirectly through the 

WAN connector. 

 Checkbox Platform All denotes that any supported mobile device can connect to the Device 

Manager directly or indirectly through the WAN connector. 

 The other fields contain the number of token-licenses you want to have active for the specified 

time period indicating that all tokens have the same duration as specified in Token #days. 

Following table explains the tokens one can request: 
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Token Edit field Description 

Development Denotes the number of development tokens. With one development 
token, the QA engineer can create, modify and execute a script. Normally 
this number is one since most of the time the QA engineer is working on 
one script at a time. 

Execution Denotes the number of execution tokens. With one execution token, you 
can execute a script. With N execution tokens, you can execute N scripts 
simultaneously. 

Tool QTP (QuickTest 
Professional) 

Denotes the number of QuickTest Professional tokens. This number is 0 or 
one since you can run only one QuickTest Professional instance at a time. 

Tool ALL Denotes the number of tool instances you can launch simultaneously. 
Currently Quick Test Professional and QuickTest Professional are 
supported. 

 

After clicking OK, you will receive an overview of requested and received licenses. If all requested 

licenses are not granted, it means that they are in use by other users. 

 

Figure 8 Token license overview 

Note that for any license installation (install new license, switch to another license or release token 

license) all devices and tools have to be disconnected. 

Handling the token license 

All token licenses have an expiration date. If the you want to release these tokens before the expiration 

date, you can do it by calling the menu item Tools, License, Release Token License or by installing a new 

license (seat, site).  Before calling one of these menu items, you need to connect your machine to the 

network so that the license server is reachable. The menu item Release Token License will release all 

tokens and switch your license to site license connecting to the same license server address that was 

used to book and un-book the tokens. 
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Managing the professional license 

The Device Manager will at startup time look to book a Professional license. You can release this license 

and use the Device Manager in Standard mode by selecting Tools, Licenses, Release Device Manager 

Pro. Performing this action will disconnect all connected WAN connectors and disable the scheduler. 

If the Device Manager is in Standard mode, you can book a Professional license by selecting the menu 

Tools, Licenses, Get Device Manager Pro. 

You can verify the mode the Device Manager is in by inspecting the menu entry in Tools, Licenses. The 

menu entry Release Device Manager Pro indicates that the Device Manager is in Professional mode. The 

menu entry Get Device Manager Pro indicates that the Device Manager is in Standard mode.  

License overview 

 

Figure 9 License overview 

At each time you can check your available licenses in menu Tools, Licenses, License Overview. The 

displayed form shows the number of licenses in use and if using a seat or token license, the number of 

licenses available locally on your PC. 

2.5. Troubleshooting 

2.5.1. The device is not able to (re)connect to the M-eux device manager  

The communication between the PC and the mobile device is using the TCP/IP network protocol. A local 

firewall installed on the PC may block the communication between the PC and the mobile device. The 

TCP/IP protocol uses ports and IP addresses to establish communications. 
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We recommend you allow communication on the following IP-address blocks: 

- 169.254.*.* (autoconfiguration IP addresses) 

- 192.168.*.* (private IP range) 

- All other IP ranges that are used for establishing connections between the mobile device and 

the desktop (e.g. Wi-Fi, Bluetooth, …) 

And on the following ports: 

- 4444, 555, 5580-5590 

2.5.2. The device manager ports are already in use 

Since the communication between the Device Manager and the script (and vice versa) is using .Net 

Remoting technology, ports are needed for communication. The ports that are used by the M-eux Test 

tool can be modified in “MeuxDeviceManager.exe.config” (see the bin folder of the installation 

directory). 

After launching Device Manager or Wan Connector you get message(s) that a port is already used on 

this machine 

 

You have to go to the configuration file of Device Manager (Wan Connector) and change the specified 

port there. For details see the User guide, section Wan Connector configuration. 

 

1. Make sure your local firewall does not block the communication of the device manager, you can 

enable the communication by: Control panel—Firewall—Allowed programs and make sure you 

have device manager listed in there and it can communicate through firewall in both home and 

public network. 
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Figure 10 Allow the communication of Device Manager on firewall 

 

If the Device Manager program does not appear in the above window, you can click the button Allow 

another program in the above picture and point to MeuxDeviceManager.exe in the bin directory of the 

M-eux Test. 
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Chapter 3: Getting your device ready 
1. Depending on the architecture of your Windows CE 7 device, place the either M-

euxAgentWCE7x86.cab or M-euxAgentWCE7ARM file into the Shared Folder of your device. You 

can find the device at C:\Program Files (x86)\Jamo Solutions\M-eux Test\setup\Windows CE 

 
 

2. Execute the file. 
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3. Restart the emulator using a soft reset. 

4. Start the M-eux Test Agent by clicking Start, Programs, M-eux Agent 

5. Enter the IP-address of the PC you want to connect to in the “Name Connected PC” field. 

 
6. Select “Connect” from the menu. 
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7. Make sure the device shows up in the device-manager on the PC 
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Chapter 4: Launching your application 
Tip: This procedure is only required for applications using the Microsoft .NET Compact Framework 

(CF). 

If the application you want to test is a .NET Compact Framework (CF) application, you need to enable 

our support for .NET CF applications. 

The .NET CF support can only be enabled if the application under test is launched by M-eux Test. There 

are two ways to launch the application under test: 

1. You can launch the app under test from the script with the command NetCFAppLaunch or 

one of its variants. 

2. You can redirect the executable and launch the app in the normal way (by the icon or the 

AppLaunch method from the script). 

Note that if you choose for option 1, the application cannot be started prior to the execution of 

NetCFAppLaunch in the script. If your application starts up automatically while booting the device, 

option 2 must be used. 

4.1. NetCFAppLaunch Method 

The NetCFAppLaunch has many variants. You need to know whether: 

- Your app runs on .NetCF version 2 or version 3.5, and   

- Wheter your app is using Resco Components and if so, the version of Resco. 

The variants are: 

METHOD USAGE M-EUX CALLING EXECUTABLE 

NETCFAPPLAUNCH Use this command for 
.NetCF version 2.0 
applications. 

ManagedWrapper.exe 

NETCFAPPLAUNCH35 Use this command for 
.NetCF version 3.5 
applications. 

ManagedWrapper35.exe 

NETCFRESCOAPPLAUNCH Use this command for 
.NetCF version 2.0 
applications using Resco 
6.11 

RescoManagedWrapper.exe 

NETCFRESCOAPPLAUNCH35 Use this command for 
.NetCF version 3.5 
applications using Resco 
6.11 

RescoManagedWrapper35.exe 

NETCFRESCO612APPLAUNCH Use this command for 
.NetCF version 2.0 

Resco612ManagedWrapper.exe 
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applications using Resco 
6.12 

NETCFRESCO612APPLAUNCH35 Use this command for 
.NetCF version 3.5 
applications using Resco 
6.12 

Resco612ManagedWrapper35.exe 

NETCFRESCO2005APPLAUNCH Use this command for 
.NetCF version 2.0 
applications using Resco 
2005 

Resco2005ManagedWrapper.exe 

The commands have 3 parameters: 

• Parameter 1: the name of your executable. 

• Parameter 2: the full path to the directory where your executable is located. 

• Parameter 3: command line arguments of the application. In most cases, no arguments are 

passed and you specify the empty string “”. 

If you execute the command, following actions take place: 

• The tool copies the corresponding managedwrapper.exe from the C:\Windows directory to 

the directory specified as the second parameter 2. 

• The managedwrapper.exe process will start up the specified application ( parameter 1) 

inside its process 

Doing so enabled our support. 

This option cannot be applied in following cases: 

• The application is started up at boot time of the system. Either you stop/kill the application 

manually before executing the NetCFAppLaunch command or you apply option 2. 

• The application is consulting the name of its process to access for example files. The name 

of the process is normally the name of the executable. By using the NetCFAppLaunch 

command, the process name is ManagedWrapper.exe. You have to use option 2 in this case. 

4.2. Redirect Method 

On windows mobile/CE an application is started up by its executable. An icon or automatic startup 

during boot refers to this executable. 

In this solution, we make that an executable of M-eux test replaces the executable of the application 

under test. The procedure is as follows: 

1. Rename the executable of the application under test: example: your executable name is 

myapp.exe. Rename it to a new name, for example: myappOrig.exe 

2. Copy the corresponding managedwrapper.exe to the directory of your executable (see table 

in option 1).  

3. Rename our executable to your name. In the example rename it to myapp.exe 
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4. Put a file in the directory with name: myapp.exe.redirect. This file is a XML file with 

following content: 
<managedWrapper> 

 <program>myappOrig.exe</program> 

</managedWrapper> 

What happens when applying this redirect setup? Here is the explanation using the example data: 

When clicking on the icon or when rebooting, the system will call myapp.exe. This is the M-eux 

application previously named managedwrapper.exe. This application will look for the 

myapp.exe.redirect file. Open it, read out the program name and startup myappOrig.exe 

With other words, the application under test is called by the M-eux test application 

managedwrapper.exe 
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Chapter 5: Your first script 
M-eux Test supports the following features on Windows Embedded Compact 7: 

- For .NET applications: Record, Learn GUI and Replay (if the application is launched by the script) 

- For C/C++ applications: Learn GUI and Replay 

The Remote Device Screen is implemented for Windows Embedded Compact 7, but the Spy and Active 

Screen functionalities are not. 

To record a .NET program, you need to use NetCFAppLaunch or NetCFAppLaunch35 to launch your 

programs. If you use .NET 3.5 framework you need to use NetCFAppLaunch35 function. For example, 

windowsCE.NetCFAppLaunch35("WinCEApp.exe", "\\Program Files\\WinCEAppInstaller", ""); 

and for 2.0 .NET framework , you can just use NetCFAppLaunch function. For more details you can refer 

to function reference. 

Before recording, please check whether you have installed .NET framework support on your windows CE 

device, you need to install the framework before installing your testing app, you can find these cab files 

in your .NET installation folder, for example the path is 

 C:\Program Files (x86)\Microsoft.NET\SDK\CompactFramework , and from the folder you can find 

suitable cab file for your windows CE system. 

Then, you can launch your app, and record on your app, corresponding code will appear on your script 

tool code area. 

For example, 

I push a button 1 on a sample app, then I will get the code 

windowsCE.monetcf_Form1.monetcf_tabControl1.monetcf_SampleApp.monetcf_1.Push(); 

afterwards I can replay it, by running my script. 

Sometimes we may find that execution is not successful, it is problem of description property, you can 

change your code of repository to delete some recorded properties, or just change Object Configuration 

from Device Manager menu Tools->Object Configuration , in that dialog you can change objects' 

properties that need to be recorded. And record again you will get a clean repository. 

To simplify finding object procedure, you can omit extra properties, just leave properties that can 

distinguish this object from others, like class name or index. 

5.1. Creating the first script in QuickTest Professional. 

This section explains how to create your first script in QuickTest Professional.  
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Any command in the expert view of the script must be specified on one line! In this document, a 

command might be printed over several lines if the length of the command exceeds the width of the 

page. 

1. Open “My Device” 

 
2. In QTP click “Object Repository” 

 
 

3. In the window that follows click “Add Objects to Local” 
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4. Then click on “Learn GUI” in Device Manager 

 
  

5. In the next window make sure your device is selected and press OK

 
6. Wait for QTP to analyze and add all the objects 
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7. Type the following line in QTP: 

 

MobileDevice("WindowsCE").MoWindow("My Device").MoObject("Shell 

Embedding").MoObject("DefShellView").MoListCtrl("SysListView32").Select "My Documents" 

 

This command will select the “My Documents” folder. 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

In order for the script to function properly, correct name of the device should be used instead of 

“WindowsCE”, hence you cannot copy-paste any command from this document. It is necessary to type 

this and all the following commands manually. QTP will automatically insert the correct name when 

you type MobileDevice( 

 

 

8. Press “Run” to make sure that the command works properly 

 

 
 

 

 

9. It is necessary to add objects to repository from every new screen. Execution of the command 

from the previous step opened ‘My documents’ folder, so we need to repeat steps 2-6 (click 

“Object Repository”-> “Add Objects to Local”-> “Learn GUI”->”OK”). 
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10. Once object adding is finished, add the following command: 

 

MobileDevice("WindowsCE").MoWindow("My 

Documents").MoObject("ReBarWindow32").MoToolBar("ToolbarWindow32_3").Select "#3" 

 

This command will make the device click the “Up” button on the toolbar 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

11. In order to complete the test case, the file explorer program needs to be started automatically 

from the script. It is a pre-condition that the file explorer is running and showing the root 

directory. Insert this line in the beginning of the script, above the existing lines:  

 

MobileDevice("WindowsCE").AppLaunch "\windows\explorer.exe","\","" 

This command will make the device open File Explorer in the root directory. 

 

12. Insert the next line under the one we added in the previous step: 

 

itemCount = MobileDevice("WindowsCE").MoWindow("My Device").MoObject("Shell 

Embedding").MoObject("DefShellView").MoListCtrl("SysListView32").GetItemCount 

This command will count the number of items in My Device directory and store the value in the 

itemCount variable. 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

 

13. Finally, add the following line to the end of the script in order to compare the current number of 

items in the directory with the value when My Device was first opened. This expected value was 

previously stored in the itemCount variable: 

 

MobileDevice("WindowsCE").MoWindow("My Device").MoObject("Shell 

Embedding").MoObject("DefShellView").MoListCtrl("SysListView32").CheckProperty 

"itemCount",itemCount 
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The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

Now the script is finished and should look like this: 

 

 

14. Press “Run” in QTP.  Once the script execution is finished, you will receive Test Results, where 

you can see the outcome of CheckProperty function.  
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5.2. Creating the first script in Microsoft Visual Studio 

This section explains how to create your first script in Microsoft Visual Studio.  

Any command in the script must be specified on one line! In this document, a command might be 

printed over several lines if the length of the command exceeds the width of the page. 

1. In Visual Studio click “File” -> “New” -> “Project…”.  

 

 
 

2. In the next window select “Visual C#” in the Project types column on the left and “M-eux Test - 

Script” under My Templates on the right. Type in a name for your script and press “OK”. 
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3. In the following window press “OK”.  

 
4. Open the “Add-in manager” dialog box from the “Tools Menu”. 

 

 
 

5. Select the “M-eux VS Addin” option 

 

 
 

6. The “M-eux Test Menu” will be added in Visual Studio 
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7. Select “Connect” from the “M-eux Test Menu” to connect Visual Studio to the device manager. 

The “Visual Studio Addin” will be listed in “Connected Testing Tools”. 

 

 
 

8. Open “My Device” 

 
 

9. Select “Learn GUI” from the “M-eux Test Menu” 
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10. Click on “Learn GUI” in Device Manager 

 

 
  

11. After the objects are added, type the following line under //Have Fun in Visual Studio: 

 
windowsCE.mo_My_Device.mo_Shell_Embedding.mo_DefShellView.mo_SysList

View32.Select("My Documents") 

This command will make the device open ‘My documents’ folder. 

 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

In order for the script to function properly, correct name of the device should be used instead of 

“WindowsCE”, hence you cannot copy-paste any command from this document. It is necessary to type 

this and all the following commands manually.  

 

12. Press “Start Debugging” to make sure that the command works properly 

 

 
 

13. It is necessary to do Learn GUI at every new screen. Execution of the previous command opened 

‘My Documents’ folder, so we need to click “Learn GUI” from the “M-eux Tool Menu” again. 
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14. And click on “Learn GUI” in Device Manager. 

 

 
 

 

  

15. Add the following command to the script: 

 
windowsCE.mo_My_Documents.mo_ReBarWindow32_2.mo_ToolbarWindow32_3.Select("#3"

); 

 

This command will make the device click the “Up” button on the toolbar 

 

16. In order to complete the test case, the file explorer program needs to be started automatically 

from the script. It is a pre-condition that the file explorer is running and showing the root 

directory. Insert this line in the beginning of the script, above the existing lines, under //Have 

Fun :  

windowsCE.AppLaunch("\\windows\\explorer.exe", "\\", ""); 

This command will make the device open My Device folder. 

 

17. Insert the next line under the one we added in the previous step: 

 

String itemCount = 

windowsCE.mo_My_Device.mo_Shell_Embedding.mo_DefShellView.mo_SysListView32.Ge

tItemCount(); 

This command will count the number of items in My Device directory and store the value in the 

itemCount variable. 
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The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

18. Finally, add the following line to the end of the script in order to compare the current number of 

items in the directory with the value when My Device was first opened. This expected value was 

previously stored in the itemCount variable: 

 

windowsCE.my_Device.shell_Embedding.defShellView.sysListView32.CheckProperty(

"itemCount", itemCount); 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

Now the script is finished and should look like this: 

 

19. Press “Start Debugging” to run the script.   

 

 
 

 

Once the script execution is finished, you will receive Test Results, where you can see the result 

of CheckProperty function.  
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5.3. Creating the first script in Eclipse 

This section explains how to create your first script in Eclipse. The test case will navigate through the file 

system of the device using mobile version of the File Explorer program.  

Any command in the script must be specified on one line! In this document, a command might be 

printed over several lines if the length of the command exceeds the width of the page.  

1. In Eclipse click “File” -> “New” -> “Other…” 
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2. In the following window select “Jamo Solutions” -> “M-eux Test” 

 

 
 

3. Specify project name and desired location 
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4. Press “Connect” button on the toolbar to connect Eclipse to Device Manager. The “Eclipse 

Addin” will be listed in “Connected Testing Tools” in Device Manager. 

 

 
 

 

5. Open “My Device” 

 

 
 

6. Click “Learn GUI” on the toolbar in Eclipse. 

 

 
 

 

7. Select the appropriate device from the list. If there is only one device connected, it will be 

selected automatically. 
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8. Once the GUI objects are added, type the following line in the end of the body of the runCore 

function of UserScript.java  

WindowsCE.Mo_my_Device1.Mo_shell_Embedding.Mo_defShellView.Mo_sysListView32.s

elect("My Documents"); 

 

This command will make the device open “My documents” folder. 

 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

In order for the script to function properly, correct name of the device should be used instead of 

“windowsCE”, hence you cannot copy-paste any command from this document. It is necessary to type 

this and all the following commands manually.  

 

9. Press “Run” => “Java Application” to make sure the command works properly 

 

 

 

 

10. It is necessary to do Learn GUI at every new screen. Execution of the previous command opened 

‘My Documents’ folder, so we need to click “Learn GUI” again. 

 

 

11. Add the following command to the script: 

 
WindowsCE.Mo_my_Documents.Mo_reBarWindow32.Mo_toolbarWindow322.select("#3"); 

 

This command will make the device click the “Up” button on the toolbar 

 

 

12. In order to complete the test case, the file explorer program needs to be started automatically 

from the script. It is a pre-condition that the file explorer is running and showing the root 

directory. Insert this line in the beginning of the script, above the 2 lines we added in previous 2 

steps:  
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WindowsCE.appLaunch("\\windows\\explorer.exe", "\\", ""); 

This command will make the device open My Device folder. 

13. Insert the next line under the one we added in the previous step: 

String itemCount = 

WindowsCE.Mo_my_Device1.Mo_shell_Embedding.Mo_defShellView.Mo_sysListView32.g

etItemCount(); 

This command will count the number of items in My Device directory and store the value in the 

itemCount variable. 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

14. Finally, add the following line to the end of the script in order to compare the current number of 

items in the directory with the value when My Device was first opened. This expected value was 

previously stored in the itemCount variable: 

WindowsCE.Mo_my_Device1.Mo_shell_Embedding.Mo_defShellView.Mo_sysListView32.c

heckProperty("itemCount", itemCount); 

The above statement should be entered on one line. In this document it is split in several lines due to 

formatting reasons. 

 

Now the script is finished and should look like this: 

 

 

15. Press “Run” ->  “Java Application” to run the script 

 

 



M-eux Test: Windows Embedded Compact 7 Getting Started Guide   

Page 41  

You can access the result via Project Explorer on the left. You may need to refresh Project Explorer 

to be able to see the result. 
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Chapter 6: Summary 
Now you should be able to start with the testing on Windows Embedded Compact 7.  

We wish you a good journey with your test adventure using M-eux Test tool. If you are facing any issues 

with our tool, or having trouble about making your test scripts for your test cases, you can always 

contact us at support@jamosolutions.com.  

mailto:support@jamosolutions.com

